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1. General 
 
The combined Remote Terminal Annunciator TELEM-RTA is a master remote 
terminal unit for coordinated substation control. TELEM-RTA provides control 
operations, data collection, protocol cross-referencing and data exchange with the 
remote control center. At the same time it announces events on the front panel. If 
required, the units can be cascaded to obtain the desired capacity of the system. 
The TELEM RTA device is similar to the data concentrator TELEM GW 5 with the 
same configuration software and main possibilities. It has a reduced quantity of 
communication ports but it has additional data collection and event indication 
possibilities. 
 
 

2. Possible Applications 
 
Data acquisition and control of regional and national electricity utilities in SCADA 
systems. In other supply networks also of regional public utilities (gas, water, 
sewage, district heating, power plants). 
 
 

3. Features 

�  Analog signal measurements 
�  Analog outputs for control 
�  Digital contact and acquisition of pulse counting info  
�  On/Off control functions 
�  Online (leased line) or offline exchange operation over Ethernet, GPRS, GSM or 

PSTN requested by an event or by the remote control centre 
�  Concentrated data acquisition and control using different communication 

protocols 
�  Protocol cross-referencing 
�  Logical operations between digital and analog signals can be described 
�  Local or remote programmable configuration 
�  Local event reporting and acknowledgment 
�  Time synchronization using GPS 
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4. View 
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5. Technical Data 

�  Number of differential analog inputs  6 
�  Analog input range (hardware specified) 0… 5 mA; -5…+5 mA;  

0…20 mA; -20…+20mA 

�  Number of analog outputs   2 
�  Analog output range    0…20 mA, 30 V max 
�  Number of isolated digital inputs  18 (16 dry contacts with an internal 

       supply, 2  with an external supply) 

�  Number of ON/OFF operations  5 (1x2 open collector and 
4x2 open drain outputs), 30 V max, 
0,1A max 

�  Number of event indicators LED  16 
�  Number of acknowledge buttons  16 
�  Number of RS 232 communication ports 4 
�  Ethernet port      optional by request 
�  SSP port for TELEM DO/DI device   optional by request 
�  Dimensions (W x H x D):   145 x 145 x 93 
�  Mounting      onto panel or DIN35 rail 
�  Weight      0,6 kg 
�  Dimensions of panel cut-out   138x138 

 

Data communication protocols 
�  To higher level system    IEC 60870-5-101,   

        IEC 60870-5-104, 
        DNP 3, 

Modbus 
�  To lower level devices    IEC 60870-5-103, 

IEC 60870-5-101, 
DNP 3, 
Modbus, 
SPA-Bus, 
Telem, 
EN 62056-21  

 
Data communication parameters  

�  Start bits      1  
�  Parity      odd, even or no parity  
�  Communication rates    from 300 to 38400 bit/sec   
       asynchronous 
�  Communication modes    RTS/CTS Control, No Control 
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Power supply: 
�  Supply voltage     24 V DC 
�  Supply voltage for dry contact input 48 V DC 
�  Power consumption    < 5 VA  

 
EMC 

�  Emission     EN-55022 
�  Immunity 

�    Static discharge    EN-61000-4-2 
�    Conducted HF field   EN-61000-4-6 
�    RF field     EN-61000-4-3 

 
�  Power and signal inputs 

�    Dielectric withstand    IEC 60255-5 
�    Fast transients    EN-61000-4-4 
�    Surge     EN-61000-4-5 

 

6. Switches  
�  1 – not in use 
�  2 – not in use 
�  3 – ON – force COM1: Addr.1, /9600/8 NI 
�  4 – ON – restore default setup* 
�  5 – OFF – oper mode, ON – Firmware update mode  
�  6 – ON - Reset 
 

* To restore the default setup, follow this sequence: 
     Sw 4 ON -> Reset -> Sw 4 OFF within 5 sec. 

 

7. Ports 
�  COM 1 – RS 232 (Communication or Firmware update) + 

GPS time synchronization 
�  COM 2 – RS 232 with all modem signals 
�  COM 3,4 – RS 232 interface 
�  COM  5  – Ethernet (optional) 
�  SSP – for connecting the TELEM DO/DI device and LED indication panel 

(optional) 
�  EXT – for connecting an external expansion device 
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COM port’s pin layout 
Pin 1 2 3 4 5 6 7 8 

COM 1 RD* - GND RX Tx - -  

COM 2 DSR CTS GND RX TX DCD RTS DTR 

COM 3,4 - CTS GND RX TX GND RTS - 

 
* Time synchronization using GPS 
 

8. Indication 
 
For operation 

�  Green LED – Blinking indicates operating mode 
�  Red LED – Failure 

 
For communication 

�  Yellow LED – RX 
�  Green LED - TX 

Green LED at SSP port - blinking indicates GPS time synchronization 

9. Digital Input Processing 
 
Digital input signals are applied to two filters, at first to “Debouncing” and then to 
“Chatter” filter. 

 
9.1 Debouncing Filter 
The digital debouncing filter prevents switching noises. 
Configuring parameters: 
Tolerant phase - a period of time during which contact bounce is “acceptable”. 
Having a tolerant period allows you to monitor and time-stamp the initial state of 
change while ignoring any subsequent contact bounces.  
Intolerant phase - a period of time following the tolerant phase during which contact 
bounce is not “acceptable”. It ensures that contact bounce is not mistaken for a valid 
change of state. 
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9.2 Chatter Filter 
Chatter Filter detects input chatter preventing filling buffers. 
Configuring parameters: 
Chatter times (changes) -  maximum allowed number of state transitions that can 
occur within a filter base period. If the number of state transitions during the filter 
period equals or exceeds the maximum allowed number of state transitions, chatter 
filter will turn ON and any further transitions will be ignored for the duration of the 
“lock-out” period. 
Lock-out period - minimum number of filter base periods during which the chatter 
filter will remain ON. The chatter filter can proceed from ON to OFF only if no state 
transitions are detected during the entire lock-out period. 
Example: Chatter times (changes) 5, Lock-out period 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ON 

Signal after 
debouncing filter 

Filter base period 

 1   2       3   4   5  

No. of  transitions >= 5 

Filter base period Lock-out period 

No transitions during 
lock-out period 

No changes on 
Lock-out period 

Signal after 
chatter filter 

Chatter filter is ON Chatter filter is OFF 

Filter’s state OFF 

Contact bouncing 

Raw signal 

Tolerant phase 
Intolerant phase 

Time-stamp of state change 

Signal after 
debouncing filter 

State change recognized 
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10. TELEM RTA Configuration Tool 
 
10.1 Getting Started 
Same configuration tool is used for configuration of RTA and GW5. The difference is 
in using the RTA IO tab card. 
When starting the TELEM GW5/RTA configuration program, user interface window 
with the main menu is opened: 
 

 
 
Warning Check communication  – If there is no connection with the RTA device then 
the warning message is displayed together with an alarm beep.  
Button “Stop sound” – Stops the alarm sound.  
 
The following parameters are shown for information:  
�  Port  – PC port which is used to communicate with GW5/RTA  
�  Link address  – Link address of the GW5/RTA port 
�  ASDU address  – ASDU address of the GW5/RTA port 
�  Status - Status of the connection. RED - no connection, GREEN - connection OK 
 
Main menu 
 
Device – For selecting the device type 
Communication - To change communication parameters, open the following 
window: 
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Fields in the communication parameters window 
 
�  Port – PC communication port which is used for communication with GW5/RTA 
�  Baud rate – Data communication rate  
�  Parity  – Use of parity control bit  
�  Flow control  – Determines whether the RTS/CTS handshaking is used  
�  Communication delay  – Delay between reception of data and the next query in 

milliseconds  
�  Link address  – Link address of GW5/RTA 
�  ASDU address  – ASDUI address of GW5/RTA 
�  ASDU address length  – Length of the ASDU address in bytes: typically 2, 

possible values are 1 or 2 
�  Object address length  – Length in bytes: typically 2, possible values are 

1, 2 or 3 
 
 
10.2 GW5/RTA Configuration Window 
 
To open the GW5/RTA configuration window, select Device > GW5/RTA Setup from 
the user interface main menu. 
 
Shortcut icons  below the menu bar:  
 

 - Open a new configuration 

 - Open a configuration file 

-  Save the configuration to a file 

 - Read the configuration from GW5/RTA 

            - Write the configuration to GW5/RTA 

 - Reset GW5/RTA. Possible Reset codes: 1 – Simple Reset; 2 – Reset 
that also clears memory buffers; 3 – Reset that also restores the default 
setup. 

 
Saving, editing and opening configuration data 
 
Configuration data is saved to the hard disk in the form of comma separated files*. 
CSV files when the Save or Save As  command is chosen from the File menu. 
Correspondingly, the Open command from the File menu opens this type of file. 
Open and Save can also be accessed via shortcut icons. 
*.CSV files can be conveniently edited with Excel software or even with the Note Pad 
program. When editing the configuration with Excel, the file has to be saved as a 
comma separated CSV file.  
 



AS Martem                                                TELEM-RTA  User Manual 
 

 

 
Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.eu 
12618 Tallinn                                  Fax: +379 639 79 80                                                 www.martem.eu 
Estonia 

11 

Table of menu items in the GW5/RTA configuration wi ndow 
 
File  Common View Help 

New 
(Ctr+N) 

Read Config 
(CTRL+R) Basic 

Help 
F1 

Open 
(Ctr+O) 

Write Config 
(CTRL+W) Advanced About 

Save 
(Ctr+S) 

Cancel Active 
Transfer   

Save As Send Reset   
Exit Interval Groups   

 
TCP/IP Settings   
Timing Settings   

 Modem Settings   
 Port Mirroring   
 Options   
 
 
10.3 Tab Cards in the Configuration Window 
 
Configuration and setting parameters can be utilized by using topic tab cards:  
Ports, Devices, Objects, Formulas, RTA IO, Status. 
A click on a tab card button switches between tab cards.  
 
Using the grid area 
Parameters can be selected or changed in the grid area cells. Values of some cells 
can be changed directly and those of others via a list box or a popup window. 
 
Values in the same column can be copied to clipboard. Use a left mouse click 
together with the Shift key to copy and a left mouse click together with the Ctrl key for 
paste operation. 
 
The status message in the bottom left corner of the window shows the result of the 
last data modification action (OK, Error, etc). 
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10.3.1 Ports Tab Card  
 
Ports/configuration tab card  is active when the GW5/RTA configuration window is 
opened. 
 

 
 
From the View menu a Basic or an Advanced  view of the Port configuration tab 
card  can be selected. The advanced view shows the additional query and echo 
suppression parameters. 
 
 
Configuration parameters of a port: 
�  Protocol  – Communication protocol used by all the devices of this port. Each 

protocol name is accompanied with a symbol l”^” or ”�  ” which indicates whether 
the port is used for an uplink or a downlink channel. For example, “Modbus � ” 
means that this port is used for downlink with Modbus protocol. 

�  Baud rate  – Data communication rate  
�  Parity  – Use of parity bit for all the devices on this channel 
�  Stop Bit  - possible values are 1,2 
�  Communication Mode  – Makes it possible to choose between the following 

handshaking options: 
 - No control 
 - RTS/CTS Control 
 - RTS Callout Request– a Request by the RTS signal to the offline modem 

for calling out  
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�  Polling / Answering Delay  – Delay between reception and the next query  
�  Port Link Address  – Link address of the device on uplink channels 
�  IEC Port ASDU Address  – ASDU address on uplink channels 
�  Length of ASDU Address  – Length of the ASDU address in bytes on uplink 

channels. Typically 2, possible values are 1 or 2 
�  IEC Object Length  – Length of the IEC object address in bytes on uplink 

channels. Typically 2, possible values are 1, 2  
More on the advance view: 
�  Up Protocol Subversion - Protocol subversion number on uplink channels 
�  Allow Routing – Allows routing of IEC 60870-5-101 protocol messages between 

the upper and the lower level channels 
�  Query Timeout in milliseconds -  Query timeout for the devices on downlink 

channels 
�  Failed Query count for disabling contr.  – Count of timeouts after which the 

error flag is raised and the query of this device is temporarily suspended 
�  Query Interval for Retry / Bal.mode Sec-s – Time period after which the 

suspended device is queried again 
�  Suppress Echo – If the sent messages are echoed back by the connected 

devices then they need to be suppressed  
If some parameters in the grid area have a grey background then these are not used 
for the chosen protocol type but you are still allowed to modify them.  
 
 
10.3.2 Devices Tab Card  

  
 
Up to 20 downlink devices can be connected to GW5 and configured on this tab card. 
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Parameters: 
�  Device nr – Sequence number of the device 
�  Objects  – Number of objects in this device  
�  Link address – Link address of the connected device 
�  ASDU address – ASDU address of the connected device 
�  ASDU address length  – Length in bytes, possible values are 1 or 2  
�  Object address length  – Length in bytes, possible values are 1, 2 or 3 
�  In use  – Indicates whether the device is in use or not. If the device is not in use 

then the whole row has a grey background.  
�  Port  – Port no. of GW5 to which the device is connected 
�  Protocol Subversion – Number of protocol subversion 
�  Protocol  – For information only. It is filled automatically according to the number 

of the used port.  
�  Minute Time Sync – Yes/No. If Yes, the device is synchronized with 10 second 

period 
�  Time Sync Forward – Yes/No. If Yes, the time synchronization which is received 

from upper channel, it is forwarded to the device  
�  Replace Event hrs – Yes/No. If Yes, events are sent to control centre with UCT 

time (the time correction value is set in Common Menu, Timing Settings) 
 
Adding devices 

By clicking on the  shortcut icon, a new device with default settings is added.  
It is also possible to add new devices with a right mouse click which makes the 
extended control menu to appear. 
 

 
 
 
 Add Devices dialog box appears.  
 

 
Set the Add Device options:  

- Number of the devices to add 
- Default settings or the device 

number from where the settings 
are derived  

- Copy Object Also 
Click the Add button. 
 
 
 



AS Martem                                                TELEM-RTA  User Manual 
 

 

 
Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.eu 
12618 Tallinn                                  Fax: +379 639 79 80                                                 www.martem.eu 
Estonia 

15 

Removing Devices 
To remove a device, select Remove Devices  from the extended control menu or 
click on the shortcut icon. 
 

 
 
Select the range of the removed devices and click the Remove  or Remove All 

button. The selected device is also removed after the warning dialog when   is 
clicked. 
 
 
Clearing Devices 
To clear the Device Tab Card, select Clear from the extended control menu. 
A warning window always appears before removing operations are concluded: 
 

 
 
Select Yes to accept or No to cancel the removal operation of the devices. 
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10.3.3 Objects Tab Card 
 

 
 
The first object of every device is used as the communication status signal of the 
device. If its value is “1”  then communication with this device is broken. 
The object (first object) of communication status signal is not counted in the Objects  
row of the Device Tab  Card. 
 
Columns: 
Type – Object’s type: digital input (DI), digital output (DO), analog input (AI), counter 
(CN) 
Analog Group – G1, G2, G3. Object group for common settings. 
 
Sub Type^  – Object’s subtype for uplink. The following dialog box opens on clicking: 
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Subtypes of object and time marking modes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

�  Sub Type v - Object’s subtype for downlink. 
�  Invert  – Object’s value will be inverted 
�  Fn.code  – Function code on the IEC 60870-5-103 protocol 
�  Info no . – Information number on the IEC 60870-5-103 protocol 
�  Index  – Object index on the IEC 60870-5-103 protocol. It indicates the order 

number of the object in message types 3 and 9 of analog measurements. 
�  Object.Addr �   – Object’s downlink address  
�  Object.Addr ^   – Object’s uplink address  
�  DB1, %FS – Deadband (% of full scale). If the value has changed less than 

the deadband then it is not spontaneously transferred. 
�  DB2, %FS – This is used instead of DB if the Crit.Min  and Crit.Max  fields are 

used and the value falls within these limits. In case of offline (GSM) channel, 
if the change in value is bigger than deadband 2 (% of full scale) then a call to 
SCADA system is initiated. 

 
�  Raw Min, Raw Max  – Minimum and maximum raw values of analog 

measurement (before scaling). 
�  Scale Min, Scale Max – Minimum and maximum scale values of analog 

measurement. 

Object 
type 

Format Time marking  

DI – 
Digital 
input 

Single 
Double 

Without time 
With Short Time 
With Long Time 
With Short Time if got with time tag 
With Long Time if got with time tag 
 

DO – 
Digital 
output 

Single  
Double 
 
Direct Execute 
Select Execute 

 

AI – 
Analog 
input 

Normalized  
Floating point 
Step position 

Without time 
With Short Time 
With Long Time 
With Short Time if got with time tag 
With Long Time if got with time tag 
 

CN – 
Counter 
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�  Forb. Ports  – Uplink port to which the object’s value transfer is blocked. To 
select uplink ports, which should not be used for transferring these object 
values, double-click on the cell of the Forb. Ports column and select the 
corresponding ports from the window that has appeared. 

 

 
 

�  Crit.Min %Fs / On Ev. Nr; Crit.Max  %Fs / Off Ev. Nr   
Crit.Min %Fs; Crit.Max %Fs – Minimum and maximum values in % from the 
full scale of analog measurements on which RTA initializes communication 
(Fig. 10.5.1). If Crit. Max and Crit. Min do not have values, DB1 and DB2 are 
in use. If Crit. Max and Crit. Min have the value ‘zero’, only DeadB1 is in use. If 
the analog measurement value is between Crit. Min and Crit. Max, DB2 is in 
use. If the analog measurement value is out of limits, DB1 is in use. 
On Ev. Nr; Off Ev. Nr  – Corresponding event number used in SPA-bus 

�  Forb. Calling  – Block object’s value transfer.  
�  Ch. Nr. – Channel nr. for SPA-bus communication protocol 
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Adding Objects 

By clicking on the  button, a new device with default settings is added. 
Objects can also be added with a right click on the device tab card. After that the 
following extended control menu appears: 
 

 
When selecting Add Objects, the following dialog box appears: 
 

 
 
 
Removing Objects 

To remove a device, click the    button or select Remove Devices from the 
extended control menu. 
 
When selecting Remove Objects from the extended control menu, the following 
dialog box appears: 
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Hints 
�  Repeated object addresses are shown on yellow background. 
�  When leaving the Object Tab Card, all objects are hidden. To see the objects 

on returning to Object Tab Card, use Expand All from the extended control 
menu that appears after a right click. 

 
 
10.3.4 Formulas Tab Card 
 

 
 
 
Columns: 

�  Type, Sub Type, Sub Type , Invert, Object Adr ^,  D B1, DB2,  Crit.Value, 
Raw Min, Raw Max, Scale Min, Scale Max, Forb.Ports,  Forbid Calling, obj. 
- as in Objects Tab Card  

�  Module  – Determines the RTA module (Main Module, Exp. Module 1, Exp. 
Module 2) 

�  DO/LED no.  – Number of the digital output (1…16) in the TLM GW-IO device 
controlled by the result of this formula or the Alarm (LED) number (1…16) on 
the LED Alarm panel that corresponds with the result of this formula. 

�  Alarm  – Alarm (LED) number (1…16) on the LED Alarm panel that 
corresponds with the result of this formula.  

�  Formula – formula string 
�  DO addr.  – Number of the digital output (1…16) in the TLM GW-IO device 

controlled by the result of this formula 
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Editing formulas 
 
Formulas can be created between the values of analog and/or digital objects. 
 
Referencing to object values 
To use the measurement object in the formula, insert an @ sign together with the 
object address up.  
Example: @101 points to the value of the object with an address to uplink 101. 
 
Constants  
Constants can be used in formulas. 
 
Example: 1.1+2.2+3 consists of 3 floating point constants 
 
Brackets  
Brackets can be used in formulas to change the priority of the operation. 
 
Example: sqrt(@101/2+@102); (@201+@202+@203)/3 
 
Operators 
 
Oper.  Obj. type  Description  Sample  *Priority  
+ DI/AI Addition @101+3,2 3 
- DI/AI Subtraction @101-0,49 3 
* DI/AI Multiplication @101*2 2 
/ DI/AI Division @101/2 2 
^ DI/AI Exponentiation @101^2 1 
< DI Greater than @101<0,499 4 
> DI Less than @101>0,5 4 
sqr DI/AI Square sqr(@101*10) 0 
sqrt DI/AI Square route sqr(@101*10) 0 
and DI Logical conjunction @201and@202 5 
or DI Logical disjunction @201or@202 6 
xor DI Exclusive disjunction @201xor@202 6 
not DI Logical negation not@201 0 
dbl DI Converts 2 single digital 

inputs into a double signal 
@201dbl@202 7 

sin DI/AI  sin@301 0 
cos DI/AI  cos@301 0 
tan DI/AI  tan@301 0 
arcsin DI/AI  arcsin@301 0 
arccos DI/AI  arccos@301 0 
arctan DI/AI  arctan@301 0 
 
* priority determines the order of operations in the formula (the highest priority is 0) 
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Notes 
�  All analog values should be scaled before making calculations; therefore, it is 

very important to fill the Raw Min, Raw Max, Scale Min, Scale Max  fields with 
Normalized values that are used in calculations. 

�  After editing the formula, the program automatically validates this formula and 
shows the result in the status area. If the formula is incorrect, the background 
of the edited formula is changed to pink and an error message is displayed in 
the status area. 

�  By clicking on the  button, a new formula row with default settings is 
added. 

By clicking on the   button, the selected formula row is removed. 
�  Formula rows can also be added, removed or cleared by using the extended 

control menu like in the Object Tab Card. It appears with a right mouse click 
on the Formula Tab Card. 

 
 
 

 
 
To add a Formula, select Add Formulas , to remove a Formula, select 
Remove Formula, and to clear all formulas, select Clear. 

�  The formulas of DI type of objects can contain AI values and floating point 
constants. If the result of the formula is greater than 0, the value of the DI 
object is “1”; if the result of the formula is less than or equal to 0, the value of 
the DI object is “0”. 

�  < or > statement: if the statement is true, the value of the DI object is 1; if the 
statement is false, the value of the DI object is 0. 
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10.3.5 RTA IO Tab Card 
 
RTA IO Tab Card allows you to determine input-output object parameters of Main 
and Expansion Modules 
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10.3.5.1 Configuration Parameters of Digital Inputs  and Counters 
 
The following data fields are configured for each input signal: 
�  Type: Digital input (DI) or counter (CN) 
 
Parameters for DI type:  
�  Subtype : Single or Double and time tagging. If the Double is selected then it 

works together with the next DI forming a pair of signals. 
�  Invert : Inverts the input signal 
�  Obj. addr.^ : Object address for the upper level device 
�  Comment  
�  Forb.Ports : Numbers of the ports to where this data object is not transferred 

(forbidden ports) 
�  Forbid calling : Possibility to forbid the callout on upper level offline channels 

(PSTN, GSM data) 
 
Debouncing filter parameters  
�  Tolerant ph.[ms ]: A period of time during which state changes are ignored. 

Range: 0 … 65567 ms. Default: 5 ms. 
�  Intolerant ph.[ms] : A period of time during which the state of digital input must 

remain unchanged. Range: 0 … 65567 ms. Default: 5 ms. 
 
Chatter filter parameters  
�  Base per.[ms] : Time interval for checking the number of changes 
�  Change count : Number of allowed changes during the base period 
�  Lock-out multiplier : Number of filter base periods after which the chatter filter 

will be reset if there are no more state changes 
 
Parameter for the CN type: 
�  Imp.cnt. : Impulse counter for the counter (CN) type. If the value change exceeds 

it then it writes the value to output buffer (creates an event) 
 
 
10.3.5.2 Configuration Parameters of Digital Output s 
 
The following data fields are configured for each digital output: 
�  Subtype : Single or Double, “Direct Execute” or “Select and Execute” 
�  Invert : Inverts the output signal 
�  Obj. addr.^ : Object address for the upper level device 
�  Comment  
�  Forb.Ports : Numbers of the ports to where this data object is not transferred 

(forbidden ports) 
�  Pulse len.[ms] : Length of control pulse in milliseconds 
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10.3.5.3 Configuration Parameters of Analog Inputs  
 
The following data fields are configured for each analog input: 
�  Subtype : Normalized or floating point value and time tagging 
�  Meas. Range : Indicates the measurement range: +-Range, +Range, 0..20mA. It 

has to mach the ordered hardware configuration! 
�  Obj. addr.^ : Object address for the upper level device 
�  Comment  
�  DB1, %Fs: Deadband in %-s from the full scale to determine the considerable 

change. If the value change exceeds it then it writes the value to output buffer 
(creates an event) 

�  DB2, %Fs: Deadband in %-s from the full scale to cause the callout on upper 
level offline channels (PSTN, GSM data) 

�  Scale min .: The scaled value on the floating point value which corresponds with 
the minimum (zero) input value 

�  Scale max .: The scaled value on the floating point value which corresponds with 
the maximum measured input value 

�  Forb.Ports : Numbers of the ports to where this data object is not transferred 
(forbidden ports) 

�  Crit.Min., %Fs : Critical minimum in %-s from the full scale. If the value falls below 
this limit then the callout is initiated on upper level offline channels (PSTN, GSM 
data) 

�  Crit.Max., %Fs : Critical maximum in %-s from the full scale. If the value rises 
above this limit then the callout is initiated on upper level offline channels (PSTN, 
GSM data) 

�  Forbid calling : Possibility to forbid the callout on upper level offline channels 
(PSTN, GSM data) 

�  Avg per.[ms] : Averaging period for smoothening the measurement. 
�  Zero zone : The zone around the zero in %-s from the full scale. If the value falls 

into this zone then it is equalized with zero. 
Remark 
Ranges of analog inputs are hardware specified. If  + - values are specified and 
range + is determined then negative values are presented as zero. Measurement 
ranges have to be determined according to the specified input values. 
 
10.3.5.4 Configuration Parameters of Analog Outputs  
 
The following data fields are configured for each analog output: 
�  Range: Determines the output range: 0..20mA or 4..20mA. 
�  Obj. addr.^ : Object address for the upper level device 
�  Comment  
�  Scale min .: The scaled value on floating point value which corresponds with the 

minimum output value 
�  Scale max .: The scaled values on floating point value which corresponds with the 

maximum output value 
�  Forb.Ports : Numbers of the ports to where this data object is not transferred 

(forbidden ports) 
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10.3.6 Status Tab Card    
 

 
 
 
Status tab card presents the status of GW5/RTA general configuration parameters 
and transfer statistics. 
 
Update  button is used to get information from the connected GW5/RTA and it is 
displayed under Device Information. 
 

11. Common Settings 
Common settings are accessible from the menu of the GW5/RTA Setup window. 
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11.1 Interval Groups 
 
Interval groups are used to specify the time interval of sending analog input value to 
the remote control center when the value has changed less than the deadband. 
Interval groups can be added to analog input objects in the Configuration tool in the 
Objects tab (Analog groups). 
 

 
 
11.2 TCP/IP Settings 
 
TCP/IP Settings are only used for GW5/RTA with an Ethernet port and used to 
determine the IP address and number of the socket port. 
 

 
 
11.3 Timing Settings  
Timing Settings are used to determine RTA initialization timeout and time zone 
correction. 
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11.3 Telephone Modem Settings 
 
Modem Settings  are used to determine calling parameters in the dial-up mode 
operation. 
 
The modem can be used only through communication port 2. Only this port has all 
the necessary handshaking signals for the modem. 
 
1. Open Ports  tab card in the GW5/RTA configuration window. 
2. Set Communication Mode  to port 2 Modem Callout .   
3. From the Common  menu open Modem Settings . 
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Callout parameters : 
 
�  Connection connecting timeout  - if the connection was not established during 

this time (seconds), GW5/RTU will try to call out again. 
�  Maximum connection duration  - if the connection is still open after this time, it 

will be closed by GW5/RTA. If the value of this parameter is 0 then GW5/RTA will 
never close the connection. 

�  Minimum connection duration  - if the connection was broken during this time, 
GW5/RTA will try to call out again. 

�  Number to call  – if the first number is busy then the gateway will call the next 
number. If all the numbers are busy then the gateway will call around the 
numbers until some number answers.  

�  Unique Device ID  - additional identification no. used when calling out (ID 
number, may be used if modem cannot send its phone number). 
 

Number Checking  may be enabled for incoming  calls. In this case, the connection 
may be established only from these 5 phone numbers maximum. (The phone 
numbers must be typed up exactly as the modem receives them) 
 
GW5/RTA initializes a communication line when one of the digital inputs changes or 
when analog measurement value changes over the determined minimum and 
maximum ranges and the callout event is not forbidden for this input. If 
communication is initialized by GW5/RTA, it terminates the connection after all data 
is sent. 
 
 

Scale Min. 

Scale Max. 

Critical Max. 

Critical Min. 

Deadband 2 

Deadband 2 

Callout events initialized by analogue  measurement   
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11.4 Port Mirroring for Redundant Channels  
 
The port mirroring menu option is used for configuration of upper level redundant 
channels. 
 

 
 
Two redundant (mirror) groups can be configured. The marked ports of one mirror 
group share the same event buffer. So if the upper level channel is switched over to 
another redundant channel then there will be no double events.  
 
11.5 Options  
 
The common settings of GW5/RTA configuration module are set up in this window. 
 

 
 
Separator characters are related to the CSV file format of the GW5/RTA configuration 
file. 
 
If the automatic restart option is marked then the program automatically sends the 
restart command to GW5/RTA after having downloaded the settings.  
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12. Specific Settings of the GPRS modem  
 
If the GPRS modem is used for communication with the central system then the 
following changes in settings are recommended.  
 
Open the Ports tab card in the GW5/RTA configuration window. 
 

 
 
The recommended changes for the upper level GPRS channel are: 
�  Querry timeout: 9000 ms 
�  UP protocol Subversion: 101b – Balanced IEC 60870-5-101  
�  Querry Interval for Retry: 255 sec. 
 
For the settings of port 2 look at the example above. 
 
 



AS Martem                                                TELEM-RTA  User Manual 
 

 

 
Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.eu 
12618 Tallinn                                  Fax: +379 639 79 80                                                 www.martem.eu 
Estonia 

32 

13. Communication Cables 
 
TELEM RTA Communication Port RJ-45 pin layout. 
 
PIN  Port 1   

RS232/Load GPS 
Port 3, 
Port4 
RS232 

Port 2  
RS232 

1   DSR 

2  CTS CTS 
3 GND GND GND 
4 RxD RXD RXD 
5 TxD TXD TXD 
6 GND GND DCD 
7  RTS RTS 
8 RX (for GPS time 

synchronization) 
 DTR 

 
 
 
 

 

RTA COM 1...4 Telem RTU 

RTA COM 1...4 

RTS

S 

CTS 
RxD 
TxD 
GND 

2 
3 
4 
5 
6 
7 

GND(port2 - DCD) 

Signal   RJ45 

RTS 

CTS 
RxD 
TxD 
GND 

2 
3 
4 
5 
6 
7 

Shield 

Pin  Signal 
RJ45 

1 

8 

RTS 
CTS 

RxD 
TxD 
GND 

2 
3 
4 
5 
6 
7 

Pin  Signal 
DB9F 

1 

8 
PC COM 

8 

1 

 
RxGPS 
GPS) 
Port 1 Port 2...4 Pin 

RTS 

CTS 
RxD 
TxD 
GND 

2 
3 
4 
5 
6 
7 

GND 

Signal   RJ45 
8 

1 

 
RxGPS 
Port 1 Port 2...4 Pin 

1 

5 

2 
3 

 RTA – Telem RTU 

 RTA – PC COM port  

RTA COM 2 

RTS 
RxD 
TxD 

CTS 

2 
3 
4 
5 
6 
7 

Pin  Signal 
DB25 

8 

1  RTA – Telephone Modem  

CTS 
RxD 
TxD 
GND 

2 
3 
4 
5 
6 
7 

DCD 

Signal  Pin 
RJ45 

8 

1 DSR 

RTS 
DTR 

DSR 
GND 
DCD 
DTR 20 Telephone Modem 

Connected: 
RJ45 - DB25 

8 - 20 
7 - 4 
6 - 8 
5 - 2 
4 - 3 
3 - 7 
2 - 5 
1 - 6 

Connected: 
RJ45 - DB9F 

5 - 2 
4 - 3 
3 - 5 

Connected: 
RJ45 - RJ45 

8 - 1 
7 - 2 
6 - 3 
5 - 4 
4 - 5 
3 - 6 
2 - 7 
1 - 8 

RTS 

RTS 

CTS 

CTS 
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14.  Notes 
 

�  If not stated otherwise on the individual pages of this document, AS Martem 
reserves the right to make modifications. 

�  Although the contents of this publication have been checked for conformity 
with the hardware and software described, we cannot guarantee complete 
conformity since errors can not be excluded. 

�  The information provided in this manual is checked at regular intervals and 
any corrections that might become necessary are included in the next 
releases.  

�  Any suggestions for improvement are welcome.  
�  The contents of this manual are subject to change without prior notice. 

 
 
 


